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President’s Message
August 2022

By Heide Stover

August was our potluck month, no competition meeting. Sharon opened 
her home to the club for the potluck. I did not attend but heard only 
positive comments. Thanks to Sharon for sharing her home. 

September we will be meeting in person back at the bowling alley. 

Till then, happy shooting!

Heide

182 West Adams Street
(On the Miracle Mile Across From The Valley Brew)

Stockton, CA 95204-5338  
Phone: 209-464-2299/Fax: 209-464-9229
Phone: 209-464-2299/Fax: 209-464-9229

www.ulmerphoto.com
Email: Ulmerphoto@aol.com

A Big Thank You to Our Sponsors!

mailto:photowlcrec%40att.net%0D?subject=
smccormick11@Hotmail.com
http://ulmerphoto.com/
mailto:Ulmerphoto%40aol.com?subject=
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2022 Calendar of Events
Every 3rd Thursday 
(Except April & Aug) 

6:30 PM
Location

Membership Meeting 
Contact Heide Stover 

h1stover@aol.com

Thursday  
September 15

West Lane Bowling Alley
Stockton

September General Meeting 
Special Subject - Things That Float

Thursday  
October 20

West Lane Bowling Alley
Stockton

October General Meeting 
Special Subject - Monochrome

Thursday  
November 17

West Lane Bowling Alley
Stockton

November General Meeting 
Special Subject - Open                                       

Prints Only

Thursday  
December 15

West Lane Bowling Alley
Stockton

December General Meeting 
Special Subject - Optical Illusions

2023 Calendar of Events
January TBA Annual Banquet

Thursday  
February 16

West Lane Bowling Alley
Stockton

February General Meeting 
Special Subject - Bokeh

Thursday  
March 16

West Lane Bowling Alley
Stockton

March General Meeting 
Special Subject -Circles

Thursday  
May 18

West Lane Bowling Alley
Stockton

May General Meeting 
Special Subject - Abstract

Thursday  
June 15

West Lane Bowling Alley
Stockton

June General Meeting 
Special Subject - Prints Only                            

(No Special Subject)
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Stockton Camera Club
July 2022 Competition Standings
Congratulations to the winners!!!

Because the bowling ally conference room was not available for SCC competition, 
our meeting was held via Zoom.

1st Place - Flying Across the Super Moon in San Francisco - Doug Ridgway
2nd Place - Tundra Swan Over Morning Reflection - Heide Stover

3rd Place - Sandhill Cranes Dancing - Heide Stover
Please check out the website  http://www.stockton-cameraclub.com/home.html”

Class A Standing TOTAL OPEN SS FEB MAR MAY JUN JULY SEPT OCT NOV DEC

Class AA Standing TOTAL OPEN SS FEB MAR MAY JUN JULY SEPT OCT NOV DEC
Heide Stover 187 150 37 37 38 37 36 39 0 0 0 0
Wayne Carlson 185 147 38 38 38 37 36 36 0 0 0 0
Ron Wetherell 150 121 29 38 0 36 39 37 0 0 0 0
Joan Erreca 92 75 17 32 0 26 0 34 0 0 0 0
Christine Blue 67 58 9 30 0 0 0 37 0 0 0 0
Ren Wright 44 35 9 0 0 9 35 0 0 0 0 0
Karleen Gansberg 35 27 8 32 0 0 0 0 0 0 0 0
Elizabeth Parrish 35 27 8 0 35 0 0 0 0 0 0 0
Sheldon McCormick 32 24 8 32 0 0 0 0 0 0 0 0
Darrell O’Sullivan 0 0 0 0 0 0 0 0 0 0 0 0
Lanny Brown 0 0 0 0 0 0 0 0 0 0 0 0

Class AAA Standing TOTAL OPEN SS FEB MAR MAY JUN JULY SEPT OCT NOV DEC
Joanne Sogsti 193 153 40 38 39 39 38 39 0 0 0 0
Em McLaren 192 154 38 39 39 36 38 40 0 0 0 0
Dean Taylor 190 151 39 39 37 39 38 37 0 0 0 0
Sharon McLemore 189 152 37 38 37 36 39 39 0 0 0 0
Doug Ridgway 189 151 38 38 37 39 37 38 0 0 0 0
Trey Steinhart 185 146 39 36 36 37 37 39 0 0 0 0

http://www.stockton-cameraclub.com/home.html


A. GENERAL RULES
1. Only paid-up members may enter club competition. 
2. Regular print and digital image competition period: Once 
each month except January. A competition year is February 
through December. Current regular meetings are February, 
March, May, July, September, October and December. The 
number of meetings may change from time to time at the 
discretion of the Board of Directors and approval of the 
general membership as facilities permit. The Annual Awards 
Dinner will be held in January.
3. A total of four (4) images (all prints, all digital or a 
combination of both) may be entered each competition 
month. A total of three (3) images may be entered in the Open 
Division and a total of one (1) in the Special Subject Division. 
The number of entries may change from time to time at the 
discretion of the Board of Directors and the approval of the 
general membership. 
4. Each image will be scored from 6 to 10 points. All prints 
or digital images receiving 9 or 10 points will be classed as an 
honor image. The title of each print or digital image entered 
will be read before being evaluated. The name of the maker 
will be read for 9-point honor winners. Maker’s names will be 
announced for the 10 point images after the Print & Digital 
Image-of-the-Month winners are chosen. 
5. A print or digital image that does not receive an honor score, 
may be re-entered one more time in the same division. 
6. A print or digital image may be entered in all divisions for 
which it qualifies; i.e., an honor image in Open may also be 
entered in the Special Subject Division at another competition. 
A print or digital image that receives an honor score may not 
be re-entered in the same division.
7. Any print or digital image that appears to be ineligible for 
competition or not qualified for a specific division could expect 
to be challenged. The Competition Vice-President shall decide 
whether or not the image is acceptable.
8. The exhibitor must have exposed each negative, slide or 
digital image entered. All images submitted for judging must 
be the work of the photographer/maker including the taking of 
the images and any digital enhancements and/or manipulation 
of the image. This does not apply to the processing of film or 
printing by a commercial processor.
9. The same image should not be entered both as a print and a 
projected digital image in the same competition.
10. In the event of absence or barring unforeseen circumstances, 
a member may submit make-up prints or digital images for 
one competition night per competition year; and whenever 
possible must submit all make-up prints or digital images at 
the meeting immediately following the month a member failed 
or was unable to submit the prints or digital images. Make-ups 
in the Special Subject Division must be the same subject as the 
month missed. Also, in case of absence a member may assign 
the responsibility of submitting his or her prints and/or digital 
images for competition to another member.
11. A club member who serves as judge cannot enter his or 
her own prints or digital images in the same competition. The 
judge’s make-up prints or digital images can then be entered 
in another competition during that competition year. This 
is in addition to the once-a-year make-up provision already 
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2022 Competition Policy

allowed.
12. Prints or digital images may be projected/viewed briefly 
before the judging of each division if the judge indicates he/she 
would like a preview.

B. PRINT ENTRY RULES
1. Each print entered must have a completed label attached 
to the back of the print including; name of maker, title, date 
entered and Division (Open or Special Subject). The writing or 
printing on the form must be legible. Labels must be attached 
on the back of the print in the upper left-hand corner for 
correct viewing of the print.
2. All prints must be matted or mounted with a total size 
(including mat board) of no larger than 18” X 24” and no 
smaller than 8” X 10”. Exception: One side of a Panorama 
Print may be no larger than 36”. Prints that are smaller than 
5” X 7” will not be accepted. The maker’s name must not 
appear on the viewing surface of the image. Framed prints 
shall not be entered.
3. Prints accompanied by entry forms should be submitted no 
later than 15 minutes prior to the start of the regular monthly 
meeting.
4. Prints receiving a score of 10 points, in each class, will be 
regrouped and judged for selection for the Print-of-the-Month 
honors. Print-of-the-Month honors will be given in Class A, 
AA & AAA. 
C. DIGITAL IMAGE ENTRY RULES
1. Digital images must be submitted in a format and by the 
deadline specified by the Competition Vice-President. Digital 
images may be submitted by email, mailed (CD) or delivered 
(CD) to the Competition Vice-President. Definition of Digital 
Image: An image taken with a digital camera, a negative, slide 
or print scanned into the computer and processed digitally.
2. Images must be in a format compatible with the projector. 
The key thing to keep in mind when formatting photos for 
submission is that the projector we use in the competition has 
a (maximum) resolution of 1400 x 1050 pixels. This means that 
any photo that exceeds this size in either dimension, could end-
up being cropped by the projector. In other words: the image 
width cannot be more than 1400 pixels and the image height 
cannot be more than 1050 pixels. If your image is horizontal, 
only change the width to 1400, if your image is vertical, only 
change the height to 1050. Do not change both. Down-sizing 
the image from the “native” resolution coming out of your 
camera also significantly reduces the file size. This helps when 
emailing the files and takes-up less space on our hard-drives.
3. The maker’s name, title of image, date entered and division 
(Open or Special Subject) must be included as the title of the 
image. When you have finished re-sizing your image save your 
image with a new title. For example do a Save as: Smith_
Sunrise Splendor_05-15_O.jpeg. (O-Open or SS-Special 
Subject). Specify whether you’re Beginner, Advanced or Very 
Advanced.
4. Digital Images receiving a score of 10 points, in each class, 
will be regrouped and judged for selection for the Digital 
Image-of-the-Month honors. Digital Image-of-the-Month 
honors will be given in Class A, AA & AAA.
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Levitation Photography Tutorial: 
Make Everything Float in Air

One evening, when I was lying on the bed with my laptop 
and camera bag next to me; editing some of my photos; 
and boom! This happens!

Houston, we have a problem.

Levitation Photography
You may have not heard of the terminology, but you must have definitely seen some stunning levitation photography on the 
internet. In levitation pictures, everything seems to be defying gravity. The model is floating, the objects around are floating and 
everything is floating.

Levitation photography is a simple concept of layer masking in Photoshop. To break it down in simple terms, a picture of the 
scene is taken without any props and models. Later, several pictures are taken with the model and the props by suspending them 
in air. Then they are all brought together in Photoshop by layer masking to form one image after eliminating the suspending 
equipment using the first image of the blank scene. Some photographers also prefer to use the cropping method rather than layer 
masking.

When you learn video editing, you learn that there are two phases to creating a levitation shot that are shooting and post-
processing.

Shooting
1. Work up a scene
Levitation photography is a creative process. You don’t actually need a pricey camera for it, even a basic point and shoot camera 
will help you create a good levitation photograph. Just work up a good scene. Think of various different positions in which you 
can make your model float in the air and how is it that you will do it. Normal methods which photographers use to suspend their 
model are:

• Using ropes. Use real strong ones so they can support the weight of the model.
• Using a trampoline or jump method, ask your model to jump up in the air while making the desired pose. Use burst mode 

to capture shots in succession.
• Using stools, tables, chairs or any other furniture for support.

But you don’t have to stick to only these methods. Whatever (safe) method that you can come up with to float your model, will 
work.

Learn Photography
Master the fundamentals of photography, from the basics to advanced techniques, and become a professional photographer.
Start Your Free Course

 

2. Set-up your camera
Apart from the trampoline method, if you are using any 
other support methods to keep you model suspended in 
the air, then you will have to use the tripod. Set your focus 
on the model and compose your scene to start shooting. 
Before you start taking pictures of the model, it’s best to 
take a picture of the blank scene.
 

https://blog.upskillist.com/levitation-photography-tutorial-make-everything-float-in-air/
https://blog.upskillist.com/levitation-photography-tutorial-make-everything-float-in-air/
https://www.upskillist.com/courses/photography/learn-digital-video-online/
https://www.upskillist.com/courses/photography/online-photography-course/
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I used the support method here. I used this bucket to 
get myself in the position and used the self timer on my 
camera to get this shot.
 

I couldn’t actually balance myself on the bucket. My 
tummy hurt. So, I waited for the self-timer to go off and 
just as it was about to happen, I posed.

It’s a good strategy to include some props as well in your 
picture. It creates a better impact and adds to the story 
behind your scene. 
It’s important to shoot the props as well in the same 
lighting condition. If you shoot the props in a different 
light, it will easily show when you try to bring them in 
the scene together. It will make the whole picture look 
artificial.

Once you have taken all the necessary shots, move on 
to processing your images and creating your levitation 
photograph.
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Processing
Import all your images in photoshop.

If you have shot a raw photo, you can make minor adjustments in camera RAW at this point, sync all your images and open them 
in Photoshop. Open them all in different Photoshop windows.

 

Crop out the model and other props
Use the pen tool to draw a path along the contours of the 
model.
 

Make the selection from the path by right clicking on the 
image. Press ctrl + X (command + X for mac) and then 
ctrl + v (command + V for mac) this will cut the selection 
out and place it on a separate layer on top of the image.
 

Do this for all the props as well and save these files 
separately (just in case).

Layer mask if necessary
To bring out the camera bag in front I will use the layer 
masking method. Since I am not going to move it from 
its position in our levitation scene, it’s easier to just layer 
mask it under the blank scene and bring out the bag in 
the blank scene.
 

https://blog.upskillist.com/what-is-a-raw-photo/
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Start creating your scene
Open the blank scene image. Go to the file where you had 
the model cropped. Ctrl + click on the layer in the layers 
panel to select the model. Press ctrl + c to copy this layer. 
Go back to the file with the empty scene and paste your 
model here. I will also tilt the position a bit to give a more 
floating effect. Continue to do so with all the other props 
and bring them into the scene.
 

Add the final touches
Crop and compose the scene further if necessary. I am 
going to increase the structure and saturation a bit in nik 
viveza (Photoshop plugin).
 

Points to remember
Mind the light condition and direction. Shoot all the 
images under the same circumstances. Or else they will 
not come together when you overlay them in Photoshop 
layers.

Think out of the box. You are trying to levitate, it’s 
something fantastic. Create fantastical scenes.

Looking to sharpen your photography skills? Join our top-rated Professional Diploma in Photography today!
Join 12+ million students who already have a head start.

Sign up today and get 4 weeks free!

Start now for free

No commitments. Cancel at any time.

To learn more about how Upskillist can help you click the button below:

Contact Us 

https://www.upskillist.com/courses/photography/online-photography-course/
https://www.upskillist.com/courses/photography/online-photography-course/
https://www.upskillist.pro/?utm_source=%40source&utm_medium=blog&utm_campaign=levitation-photography-tutorial-make-everything-float-in-air


 

Levitation Photography Techniques and Tips
3 ways to achieve amazing levitation photography quickly and easily

If you’re not a magician, it may seem hard to shoot surreal 
levitating images. How can you levitate a model, an object, 
or an animal? Online, you can see photos of a woman 
suspended in midair, a candle floating without assistance, 
a couple carried only by balloons, someone soaring high 
above the cityscape. Sound surreal? You can accomplish 
levitation photography in a few easy steps. The Skylum 
team has researched levitating shots, and we’re ready to 
share some of the photography techniques and winning 
floating poses with you. In fact, you can create this effect 
using Luminar, Photoshop, or even just your camera! 

Luminar is a photo enhancer that can help you accomplish more by doing less. Safely 
store and organize your photos. Add incredible looks. Edit quickly and efficiently. Or 
even make someone float. Don’t believe it? Download Luminar now for free and see for 
yourself. 
Luminar 4 Your photography. Elevated. 
Replace the sky in your photos, instantly! Boost details with AI Structure. Discover 
more amazing tools in the new Luminar 4.
• AI Sky Replacement 
• AI Structure 
• 60+ cutting edge features 
• Instant Looks 
• And more 

Method #1 Jumping as a levitation trick
The easiest way to give the look of levitation is by jumping. 
Choose a complementary background and then ask your 
model to jump. There’s not much magic to it. If you want 
your props to float, whether it’s a book or a candle, the 
same principle applies. Make sure there’s no one around 
when you’re throwing the objects and that they aren’t 
fragile enough to break when they hit the ground. The 
benefits of this levitation trick are that it’s quick and 
easy and you don’t have to do much during editing. But 
sadly, you can’t plan the precise outcome. Moreover, your 
models may not be too happy about jumping all the time, 
especially because it could lead to injuries. 

Method #2 Levitating with furniture 
If you’re not too fond of jumping, there’s a way to 
accomplish levitating photography with the appropriate 

furniture and some photography techniques. You’ll need a stool, ladder, little table, or anything that you can balance your 
model on. Set your camera on a tripod. Take a photo of the model balancing on that piece of furniture. Ask them to stand, lie, 
or sit. Without changing the position and settings of the camera, take a second photo of only the background, without the model 
and the piece of furniture. Then you’ll need to know how to remove something from a picture. After you do this in Photoshop or 
Luminar, there will come the tricky part of combining the two images and making sure that the space previously occupied by the 
furniture looks natural. This way, you’re “borrowing” parts from your background photo and applying them to the space where 
the furniture was. The result is an effortlessly levitating model!
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https://skylum.com/blog/levitation-photography-techniques-and-tips
https://skylum.com/luminar/photo-enhancer
https://skylum.com/luminar
https://skylum.com/blog/how-to-remove-unwanted-elements-from-a-photo
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Method #3 Levitating with props
This way suits professionals and those who can spend a little extra money on the setup. You can always arrange your levitation 
photo with cords, strings, or other props to make objects float in the air. This is a great idea if you want to balance multiple 
objects in midair around the model and you can attach them all with strings or cords to the ceiling or a tree. Make sure that 
your model feels comfortable suspended and don’t let them stay like this for too long. This option allows you to only edit out the 
strings. The clothes and hair of your models will fall down naturally, creating a great levitation trick. 

Levitation photography explained
Now that we’ve revealed the magic, let’s take a closer look at some of the photography 
techniques used in levitating photos. 
Photography gear and model
The most important thing you need is a camera, a tripod, a willing model, and some 
suitable furniture. Other than that, you can also grab a fan (to create a floating effect 
for long-haired models), some light reflectors, and other props. Make sure that the 
model knows what they’re getting themselves into: floating poses are not a walk in 
the park. They’ll often have to balance in uncomfortable ways to create the illusion of 
levitation. 

Other props
Don’t overlook seemingly tiny details, like the model’s 
outfit or the setting for the levitating scene. If you want to 
create a floating effect, don’t choose extra tight clothes for 
your model. Choose something light that can float around 
or otherwise give the illusion of movement. Levitation 
photography works wonderfully with dresses and long 
scarves and with skirts and unbuttoned shirts. If you 
want to create a beautiful thematic scene, think about 
the space beforehand. What kinds of objects would best 
suit this scene? If the levitation occurs because of strong 
wind, how does it affect the other objects in the room? 
Maybe you need to open a door or a window, bend some 
small trees and bushes, or make sure that the room is in 
disarray. Even magic needs logic to look believable! 
 

Weather
Try to schedule your shoot for a cloudy day. This is important because overly dark shadows from your objects will be hard to edit 
out in post-production. Always make sure that the shadows are realistic and don’t give away your levitation magic. Sometimes 
photographers invite assistants to keep the model upright or hold some objects. In this case, also make sure to remove the 
shadows from beneath them when you’re editing your photos. 
Shooting angle

An important part of your photography technique is the shooting angle. The shooting angle can make a difference. Shooting from 
a low angle will create an illusion that the model is higher in the air. However, this also means that your prop may cover parts 
of the model’s body. That’s a very hard misstep to fix in post-production. Make sure that the prop remains in the background 
in relation to the model. Shooting from a higher angle will not create a levitation photograph, but rather a falling one. However, 
you can experiment with different shooting angles until you’re satisfied with the result. 

https://petapixel.com/2015/02/10/levitation-photography-tutorial/
https://digital-photography-school.com/levitation-photography-7-tips-for-getting-a-great-image/
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Levitation photography ideas
Now that you’re ready, here are some great ideas for 
how to levitate your models and objects and boost your 
creativity in levitation photography.  
Consider the pose
The model’s pose is really important. Your levitation shots 
should be believable. The pose might change depending on 
the narrative. Someone using magic and defying gravity 
and someone being blown away by a gust of wind entail 
different photographic details. Sure, you can ask your 
model to sit in the lotus position, pretending that hard 
meditation did the trick. But make sure that the model 
looks like they’re floating: someone standing casually or 
leaning against a wall might not be a good idea. 

Levitation with objects
If you don’t want to levitate people, objects will do just fine. You can suspend 
a bottle over a book, eggs over a pan, or a tea set in midair. But we advise you 
to choose small objects that can’t break easily. For example, you can make 
paper cranes float and they’ll create a stunning and surreal effect. Another 
photography technique is to suspend multiple objects using one string, 
creating a motion effect.
 

Balance two people
How can you levitate two people? The same principle applies, but when levitating two or more people, the stakes are higher. 
Think of beautiful floating poses beforehand. Balance everyone correctly and make sure that the shadows are on point. You 
can always make only one of the models float while the other is holding their hand and keeping them from flying away. The 
composition is your way to express your creativity, but your models should feel comfortable, know exactly what they’re doing, 
and feel safe balancing on furniture or props. Moreover, floating poses should look believable in post-production, including the 
hair, outfits, shadows, and even facial expressions. 

Create a story
Levitating photography is one of the most creative and artistic photography techniques. You can tell a whole story with one 
photograph and winning floating poses. By making your model levitate above a bed, you can convey the surrealness of dreams. 
By making a young man with a flower float above the ground, you can convey the feeling of love when you rush on a first date. 
Think of your personal levitation definition: something romantic and beautiful, or a scary and surreal experience. Then tell your 
story through photographs. There are endless possibilities for you to discover with this wonderful technique. 

Use colors
You can enhance any photograph by using the right colors. Red for passion, blue for melancholy, black for gloom. Create a 
feeling that your model is lighter than a feather by dressing her in a white dress. Use a gloomy background and dark tones to 
create the illusion of sadness around your floating model. When you create a story through subtle details, you’ll be able to add 
depth to your photographs. 

Levitation in Photoshop
If you know how to cut something out in Photoshop, you’re already ahead of the game. In this quick tutorial, we’ll let you know 
exactly how to make a levitating photo in Photoshop using layers. 

https://skylum.com/how-to/how-to-cut-out-image-in-photoshop
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Purple Iris
Em McLaren

 The Redwood Eye
Ron Wetherell

1. Open two images in Photoshop: one with the empty background and the other with your floating subject. 
2. Put both of them in the same file but in different layers. To do so, select the image with the model and copy it. This can be 

done through the Select menu by choosing All, then going to Edit > Copy to grab the image. Next, paste it on top of the 
background photo (the background photo will not be visible). 

3. Add a layer mask. Go to the Layer menu and choose Layer Mask, then choose Reveal All. In the layers palette, you can see 
that a white box is shown next to the layer. 

4. With the layer mask added, simply paint out the object used for levitation. Select the brush from the tools and make sure 
you’re painting in black. Use a white layer mask with a black brush to paint the top layer out and see how the background 
shows through. 

5. Add any corrections you wish to make the photo seem more natural. 
 

The Clone & Stamp Tool

This tool replaces unwanted pixels with pixels that you 
target. First, set a sample point from an area with pixels 
you want to mimic, then paint into unwanted areas. The 
Clone & Stamp tool is often used to remove blemishes or 
dark spots from skin, but it can also accomplish levitating 
shots and other photos. After you’re done, Luminar also 
offers feathered brushes that blend the strokes easily.  
1. Open the picture that you want to turn into a 
levitation photo. 
2. Select the Clone & Stamp tool in the top toolbar, or 
press Cmd+J. 
3. When you find an area to Clone & Stamp, hold 
down the Option key and click on a clear area near the 
furniture. 
4. Click and paint out the furniture you want to 
remove. Try blending multiple strokes together and 
lowering the opacity of the brush for the best results. 
5. After each stroke, Luminar blends the image and 
updates the screen to show the new pixels. Continue 
to examine the results and make additional strokes as 
needed. Click Done when you’re satisfied with the result. 
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Using the Erase tool
Another photography editing technique is to use the 
Erase tool. There’s no need to select the pixels you want 
to mimic with this tool. Simply click and paint over the 
unwanted areas – in this case, furniture, supporting 
strings, and shadows. Luminar analyzes the surrounding 
area and generates a new texture based on what is near 
the spot that you picked. The Erase tool also matches the 
texture, lighting, and shading of the original pixels. It’s 
fast and easy to use.

1.   Open your image with unwanted details. In this levitation shot, there are still some footprints in the sand.
2.   Select the Erase tool by clicking the Tools menu in the top toolbar. 

3.   Simply click and brush over the unwanted area, in this case the footprints. If you have a large area to select, choose the 
Polygonal Lasso tool.
4.   When you’ve made a basic selection, click on the first point to close the loop. 

5.   Click the Erase button to remove the selected areas. 
We hope that this article was useful and that you learned how to levitate your models! 

If you’re interested in trying out the Clone & Stamp or the Erase tool for your levitation photography, click the button below 
and try Luminar right away. Take advantage of our free trial to see if Luminar suits your workflow. 
Follow Skylum Software on YouTube // Get the latest videos, tips, and photography inspiration each week! 

https://www.youtube.com/user/macphunsoftware
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Understanding Shutter Speed
by Chris Gheen

As a photographer, one of the biggest components of 
nailing your shot is ensuring you have the correct shutter 
speed. This aspect of the exposure triangle is perhaps 
the most critical component of an image. Where ISO or 
aperture may influence the brightness or artistic nature of 
a photograph, a mistake when choosing a shutter speed can 
render an image completely useless. By managing shutter 
speed carefully, a photographer can create art, capture a 
fleeting moment, or simply depict a more accurate vision 
of the scene before them. There is a direct correlation 
between the sharpness of an image, and the shutter speed. 
To have an image with intentional blur (caused by a 
slower shutter speed), a photographer conveys motion. 
By speeding up the shutter, a photographer can capture 
an image that they may not even be capable of seeing 
with the naked eye. The opportunities for creativity are 
limitless, so let’s take a look at how to utilize the shutter 
speed to make the most of your images. 

The shutter is the part of the camera that blocks or prevents the camera sensor or film from being exposed to light and capturing 
an image. The majority of digital cameras will have either an electronic or mechanical shutter, and some may have both. When 
the shutter is closed, the camera is incapable of capturing an image, as the sensor will be completely blocked from all light and 
unable to produce an image. While the shutter is open, the camera’s sensor (if shooting digital) will begin processing light on a 
photosensitive electronic processor, converting light rays into data points. These data points are what will eventually become 
your image.
 

When taking a photo, pressing your camera’s shutter 
button will cause the shutter to open, and will expose 
the sensor to light for a set length of time. That time 
measurement is known as the shutter speed. The longer 
the sensor is exposed to light, the more light is picked up 
and the brighter an image becomes, ultimately leading to 
an all-white light scene as the processor is overwhelmed 
with data.

You can select certain settings where the camera will make the decision regarding an appropriate shutter speed. When shooting 
in “Manual” however, it is the photographer’s job to adjust the shutter speed as lighting changes to ensure the data captured 
by the sensor is balanced enough to ensure a quality exposure. Shutter speed is displayed in camera typically as either a whole 
number or a fraction with 1 as the numerator (the number on top).

Examples of shutter speed indications on your camera would look like 250, 1000 or 1/30, 1/100. Once shutter speeds dip below 
about a half second, cameras will typically add a quotation mark to differentiate between full second and fraction of a second 
exposures, 2”, 0.5” or 10”. 
 

https://blog.backcountryjourneys.com/Understanding-Shutter-Speed?utm_source=ONTRAPORT-email-broadcast&utm_medium=ONTRAPORT-email-broadcast&utm_term=Last+Minute+Fall+Deals+2022&utm_content=Understanding+Shutter+Speed&utm_campaign=08312022
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There’s a wide array of benefits that come from 
manipulating your shutter speed to produce an image. 
The longer your shutter is open (referred to as a slower 
shutter speed) results in brighter images, and the ability 
to convey motion through the use of blur. Opening the 
shutter for a shorter length of time (faster shutter speeds) 
results in less light hitting the sensor, but also allow the 
photographer to freeze motion in the image, and can 
result in a more crisp image if all other variables are 
equal. Wildlife photographers are often having to walk 
the line between fast shutter speeds and dark imagery due 
to the need to freeze a bird or animal in the frame. By 
shooting at higher shutter speeds, the photographer will 
need to utilize other aspects of the exposure triangle to 
brighten an image while compensating for the darkness 
caused by a fast shutter speed.

So you may be asking yourself, “Self, all this talk about varying light and shutter speeds sounds well and good, but what do I do 
with all that information?” Well, that’s a great question. There’s a ton of ways to manipulate light and motion within your frame 
by adjusting your shutter speed to produce a variety of image styles.

 

Slow Shutter Speeds
As a photographer, or even just as someone who 
appreciates photography, you may have seen photos like 
this one, depicting a blurred stream or water feature, 
while other parts of an image stay sharp. This effect is 
achieved by placing the camera on a tripod and reducing 
your shutter speed to at least ⅛ of a second or slower. I 
typically shoot for ½ second to 2 second exposures, based 
on how soft or blurry I want my water to be. 
Faster shutter speeds will result in less blur, while longer 
shutter speeds can result in a softer, almost ghost-like 
appearance from the water. The resulting water blur has 
become iconic in shooting intimate nature scenes and 
depicting the natural movement of a waterfall in a single 
image. This is also a great tactic when shooting ocean 
scenes, to give a fog like effect along the shore from waves 
coming and going. To accomplish this, however, shutter 
speeds closer to 5-10 seconds may be necessary.

One of my favorite ways to play with long shutter speeds 
is with astrophotography. By switching your camera to 
“bulb” mode, you can use a remote shutter to keep your 
camera’s shutter open as long as you’d like, well beyond 
the pre-programmed 30 second limit on most cameras.
 

High Shutter Speeds
Where a slow shutter speed can be used to create a more intimate, artistic scene, high shutter speeds can be utilized for freezing 
action in a way that may not be able to be seen without the use of a camera. Things like a bird diving into a river, a bison running 
from a predator, or a fish jumping out of the water can all be frozen in an often impressive manner that creates a bolder impact. 
Fast moving subjects need to be shot at very high shutter speeds to ensure a sharp, well frozen image. 
When shooting birds of prey, I like to ramp up my shutter speed to over 1/2000, and if the light affords me the luxury, sometimes 
as high as 1/4000.



17

While most fast-moving animals don’t need to be shot 
at 1/4000, birds of prey have extremely long wingspans, 
resulting in incredibly fast-moving feathers at the wing 
tips. Where smaller songbirds can often be shot at around 
1/1000, the fast-moving outer feathers of a larger winged 
bird can often come out blurry even at shutter speeds 
as high as 1/1500. By shooting at 1/2500 or 1/3000, you 
can often ensure that each individual feather will be 
suspended in air in a crisp display of the raw power of 
the bird.

But what about all of the other times when you don’t need 
to shoot at an incredibly high or low shutter speed? How 
do you decide what shutter speed to use then? My advice 
here is to first ask yourself a few questions… Are you 
shooting on a tripod? Is anything in the frame potentially 
moving? What is your focal length? These questions will 
help to make it very clear what a rough starting point 
may be for a shutter speed. If shooting on a tripod, there 
is limited potential for camera movement or shake, and 
thus, a lower shutter speed is just fine, allowing for lower 
ISO and a sharper aperture.

If you are not shooting on a tripod, you’ll need to decide 
what’s more important, between higher detail from a low 
ISO (and therefore lower shutter speed) and thus higher 
potential for camera shake/blur, and less shake from 
higher shutter speeds, combated by higher ISO or wider 
aperture. Typically, in order to keep your exposure the 
same, moving ISO up means moving shutter speed up.

Another concept to understand is that at certain focal 
lengths (zoom for the new folks) the camera shake from 
shooting handheld is exaggerated. The more zoomed in 

you get, the more pronounced the camera shake can be, and thus blur your images when shooting hand held. To combat this, a 
good rule of thumb is what is known as the hand holding rule. When shooting hand held, try to keep your shutter speed higher 
than your focal length (as measured by the 35mm standard). For example, if shooting a full frame camera at 100mm, ensure 
your shutter speed is over 1/100. If shooting at 250mm, make sure your handheld shutter speed is at least 1/250. You get the idea. 
Take note that this is the full frame or 35mm sensor equivalent, so be sure to adjust for the crop factor of your camera. If your 
lens has a built in image stabilization (or vibration reduction for you Nikon folks) this guideline is not as important, but can 
still be helpful in ensuring the fact that you’re shooting handheld isn’t impacting your shot. The hand holding rule is useful is 
minimizing blur from camera shake, but will not have an effect on the blur caused by a moving subject.

The best thing you can do for your photography is be intentional. If a blur looks intentional it is seen as art. If a blurred subject 
looks unintentional, it’s a bad photo. It’s up to you, the photographer to use these tools to convey a subject that is intentionally 
blurred or intentionally sharp. But whatever your choice, make sure it’s done in a way that shows you’ve thought carefully about 
your image and I’m sure you’ll walk away happy with what you’ve got.

Now get out, practice modifying your shutter speed, and see what you can come up with! Happy shooting!

Chris Gheen
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